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Welcome to the SAP System 
 
 
 
The ERP 2005 System is the Client Server version of SAP. 
 
 
 
 
What does the catchphrase “Client Server” mean? 
 
 
 
 
 
A client is a self-contained unit within the ERP 2005 system with separate master records and sets of tables.  
A server is a data station in a local network, which performs particular functions within the network. 
 
 
The client you will be working in is dependent on the role of task to be performed.  For example, during a 
training session, you will most likely be working within a Training client so as not to “contaminate” the data in 
the Production client.  The Production client is the live-working environment, the data of which needs to 
remain pristine.  Your instructor or system administrator will instruct you as to which client you should utilize. 
 
 
The Client concept enables the joint operation, in one system, of several enterprises that are independent of 
each other in business terms.  During each user session, you can only access the data of the client selected 
during the logon. 
 
 
 
 
 
 

Who should take the Basic Navigation Training Course for ERP 2005? 
 
 
Anyone just starting out, in terms of working within the SAP Environment, should take the ERP 2005 Basic Navigation 
Training Course.  The basic techniques and procedural information to be taught in this course will be utilized in all SAP 
applications. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Revised 1/8/07 3  



mySAP ERP 2005 Basic Navigation Training 

 
 

Fundamentals 
 

Using the ENTER or RETURN Key 
 
 
In the instruction of this course, you will be instructed to use the ENTER key on your keyboard.  If your keyboard does 
not have an ENTER key, use the RETURN key on your keyboard.  On many keyboards, the keys may be used 
interchangeably. 
 
 
The ENTER icon is an ever present symbol on the views in the system.  Whenever an instruction calls for you to 
press the ENTER key on your keyboard, you may utilize this icon instead by clicking on it once with the left mouse 
button.  Pressing the ENTER key on your keyboard performs the exact same function as selecting this icon with the left 
mouse button. 
 
 

About the screens in the Manual 
 
 
The screens utilized in this manual have been captured from the Standard SAP Environment.  Because the system may 
be customized for each individual company’s needs, the views on your monitor may appear slightly different than the 
views depicted in this manual.  The differences, however, do not and will not affect the manner in which you work 
within the SAP Environment. 
 
 

Entering data in fields 
 
 
A field is a single unit of information, such as customer’s name or account number.  Most views in the system contain 
fields in which you enter data or that provide information for the user. 
 
To enter data into a field, position the cursor in the field and click once with the left mouse button to activate the field, 
and then proceed to key in the requisite data.  Make certain that the cursor is positioned at the beginning of the field.  
If a field is already populated, you may simply key in data over the existing entry.  Keep in mind that depending on the 
configuration of your system, some fields contain default data that is for display only; consequently, you cannot change 
or delete data in these fields. 
 
 

Moving from field to field 
 
 
After you enter data in a field, or when you wish to skip a field, use the following keys to navigate between fields. 
 

TAB Moves the cursor to the beginning of the next field. 
 

SHIFT + TAB Moves the cursor to the beginning of the previous field 
 
You may also move the cursor to any field or position within a field by using the mouse or the arrow keys on your keyboard. 
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Logging on & off 
 
 

Logging on for the first time - Requirements 
 
 
  To logon to the SAP System for the first time, you will need the following: 
 
 

• A Client Number (provided by your system administrator or instructor) 
 

Client number:_________________________ 
 
 

• A User Name (provided by your system administrator or instructor) 
 

User Name:____________________________ 
 
 

• An Initial Password (provided by your system administrator or instructor) 
 

Initial Password:________________________ 
 
 

• Your own Password (keep confidential) 
 
 
 

Creating your own Password 
 
 
  To create your own Password, follow the guidelines below: 
 

• Use any combination of characters (for example, a thru z, 0 thru 9, or punctuation marks 
 

• Use at least 6, but no more than 40 characters 
 

• Do not begin with a question mark, an exclamation point or a blank space 
 

• Do not begin with three (3) identical characters 
 

• Do not include any sequence of three characters that are contained in your user name 
 

• Do not use “pass” as your password 
 

• Must be different from the last 5 passwords 
 

) NOTE:  
• Your password is case sensitive! 
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Steps for Logging on the First Time 
 
 

In the steps below, and throughout the documentation of the manual for this course, you will be 
instructed to hit the TAB key on your keyboard following the entry of data into a field in order to 
move to the beginning position of the next data field. 

 
 

Step 1: Accessing the Logon Screen 
 
 

) NOTE:  
• The approach to be taken in terms of accessing the Logon screen (an example of which 

is shown below) will invariably be different for each client and training session.  Your 
instructor will provide the guidelines necessary to access the logon screen. 

 
• Once access to the SAP logon screen has been realized, continue with the 

documentation provided on the following page. 
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Step 2: Populating the SAP Logon Screen 

 

 
SAP Logon Screen 

 
 

 
 
I. In the Client field, enter the client number provided by the instructor; then press the TAB key to move 

the cursor to the User field. 
 
 

II. In the User field, enter your username; then press the TAB key to move the cursor to the Password 
field. 

 
 
 III. In the Password field, enter the initial password provided by your instructor; then press the TAB key to 
  move the cursor to the Language field. 
 
 
 

NOTE:            
• If you wish to change the data in any field, defaulted or not, simply type over the existing entry. 

 
 
 IV. Hit the ENTER key on your keyboard or select the Enter        icon located at the top left of the view. 

initial
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 A pop-up window in which  
you enter a new password displayed. 
        
       
        

  
  

 
 
 
 
 

V. Enter your new password in the New password field, press the TAB key and re-enter your new 
password in the Repeat password field.  As you type the passwords, you will not see them. 

 
 
 
 
 
 
 VI. Press the ENTER key on your keyboard or select the       button located within the pop-up window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
You have just changed your password and a copyright 
notice similar to the one depicted will display. 
 
 
 
 
If a pop-up window is displayed instead of the copyright notice, 
you have either made a mistake in entering your new password 
or created an invalid password.  (If you need help to create a 
valid password, see “Creating your own Password” on page 5 
of this document).  The pop-up window contains a message 
describing the mistake.  To remove the pop-up window, press the  
ENTER key.  Repeat steps V and VI above. 
 
 
 
 
 

You should only see this screen 
the first time you log on. 
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 VII. Press the ENTER key on your keyboard or select the Continue       button located within the copyright 
  notice box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
SAP Easy Access View 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The copyright notice is removed, and you have logged onto the system. 
 
 

Remember, you may see a slightly different screen depending on how your system is set up. 
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Subsequent Logons 
 
 

 
 

 

The first time you logon, you typically create your own password, as described in the previous section. The next 
 time you logon, you will use the password created during the initial logon. 

 
 
 
 
 
 
 
 
 
 

 
 
 
To logon, enter the appropriate data in the Client, User, Password, and Language fields and hit the ENTER 
key on your keyboard.  You have logged onto the system. 
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Logging Off 
 
 

 
 
 You are able to log off the system from any screen or application. 
 
 
 To log off: 
 
 1. From the Menu Bar, follow the Menu Path: System >> Log off as depicted below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Log off pop-up window is  
displayed.  You now need to confirm 
that you want to log off. 

 
 
 
 
 
 
 
 2. Select the                      button located within the Log Off dialog box. 
 
 
 All your system’s windows and applications are closed, and you are returned to your windowing environment. 
 

MENU BAR 

Exercise: Log off then log on 
using student # and password 
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Changing Your Password 
 
 
You may change your password at any time (only once in one day).  For security reasons, however, your system 
administrator may require that you change your password on a scheduled basis.  In this case, you will receive a 
message from the system that it is time to change your password. 
 
 

Change Password 
 
 
You will be changing your password from the logon screen before you logon to the system. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. In the Client field, enter the client number; then press the TAB key to move the cursor to the User 
field. 

 
 

2. In the User field, enter your user name; then press the TAB key to move the cursor to the Password 
field. 

 
 

3. In the Password field, enter your current password; then press the TAB key to move the cursor to the 
Language field. 

 
 

4. Click on the                       button located near the top of the view (on the Application Toolbar). 
 
 
 
 
 
 

We will not be changing the password at this time, 
but identify location of information for future use 
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5. Enter your new password in the New password field, press the TAB key and re-enter your new 
password in the Repeat password field.  As you type the passwords, you will not see them. 

 
 
 
 
 
 
 

6. Press the ENTER key on your keyboard or click once with the left mouse button on the      button 
located inside the pop-up window. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

A pop-up window in which  
you enter a new password displayed. 
      
       

  
        

  
 

Provided you have not made any mistakes, the SAP Main Screen will display. 

Exercise: Change Password 
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Multiple Logons 
 

) NOTE:  
• Multiple logon sessions by one individual are always logged in the system beginning with 

the 4.6 release of SAP.  This is for security, as well as for licensing reasons.  Should you 
attempt to logon more than one time, the License Information for Multiple Logon 
dialog box shown below will display. 

 

 
Multiple Logon Warning Dialog Box 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Should you receive the information dialog box shown above, select the radio button corresponding to the action 
you wish to take by clicking once with the left mouse button on the radio button itself. 

 
 
 Press the ENTER key on your keyboard to carry out the function selected in the previous step. 
 
 
 

RECOMMENDED 

Should you attempt to log on more than one time, for example at a different PC, 
the message above will appear – recommended option is to terminate this log on  

 
 
             
 

Revised 1/8/07 14  



mySAP ERP 2005 Basic Navigation Training 

 

Learning the Basics 
 
 
This chapter describes how to use the Graphical User Interface (GUI). 
 
 

Looking at Parts of the Window 
 
Provided below is a brief description of the Window.  A more detailed explanation of the elements shown below 
will be provided in the coming pages. 
 

 
Window Menu (icon) – Used to display a menu for managing the Window. 
 
 

Standard Toolbar – A menu bar containing buttons for performing the most common tasks. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Title Bar – Identifies the current 
application or task. 

Application Toolbar – This toolbar contains buttons 
for functions and choices (you click on a button in this 
toolbar to select the function). 

Menu Bar – Contains the menus currently available 
(which menu appears in the menu bar changes depending 
on which application and task you are currently utilizing). 

Status Bar – The Status Bar is a region on an SAP screen where error and warning 
messages are displayed.  In addition, user prompts and  messages indicating the system 
status may be displayed here.  Finally, the Status Bar also contains the system name (with 
the session number and client number in parentheses):  Can be opened and closed via the 
arrow      button. 

Program 
application
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Window Menu (icon) 
 
 

 
Menu Bar 

 
 
 
 
 
 
 
 

By selecting the Window Menu icon located in the upper most left hand corner of the view, the menu shown 
below will display (see representation below). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The menu returned is utilized to manage 
 (maximize, minimize, move and so on) the 
 windows of the SAP Environment.  Additionally, 
  new sessions may be initiated from this menu. 
 
 
 
 
 
 If an option in the Menu is shaded gray, the option is not available.  For example, please note that the Restore  
 option in the menu above is shaded gray, and thus not available for the current application. 
 
 
 
 
 
 
 

 
 

Stop transaction can be very useful should you 
realize that you have made a mistake/error and 
need/want to stop the transaction.   
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Menu Bar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
             
 
 
 
 
 
 
 
 
 
The Menu Bar contains the menus that consist of sub-menus and/or functions that perform an action.  Which menus are 
currently available on your screen change depending on which application or task you are using.  Consequently, you will 
see different menus as you work on different tasks.  See the section on the following page designated “Selecting menus 
and functions” for instructions on how to navigate the Menu Bar. 

 
Menus contain sub-menus and functions.  In the example below, the menu Purchase order, the sub-menu Create with 
Reference, and the function To purchase req. are selected. 
 
 
 
         Menu  Function 
 
 
 
Menu Bar 
 
 
 
Sub-menu 
 
 

) NOTE:  
• Remember, if an option is shaded gray, it is not available for the current application. 

 
 
Tip To display all the menus in a Menu Bar, click once with the left mouse button on a menu and drag the cursor  
 across the menus in the Menu Bar. 

Hold mouse over first selection of menu bar 
Left Click for drop down  
Slowly slide mouse along menu bar to view other drop downs (sub menus)

Revised 1/8/07 17  



mySAP ERP 2005 Basic Navigation Training 

Selecting Menus and Functions 
 
 

You can select menus, sub-menus and functions with either the mouse or the keyboard.  Keep in 
mind that a sub-menu, which is “subordinate” to a menu function, will have an arrow to the right of 
the item (see below). 

 

 
 
 
 The menu chosen in the example below is the Material menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Entries on the Material menu that are   Entries on the Material menu that are functions. 

Sub-menus (note the arrows, an indication 
that this is a sub-menu). 
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Using the Mouse 
 
You select menus, sub-menus, and functions by clicking on them. 
 

 
 To select a menu: 
 
 

¾ With the left mouse button, click on the menu name you wish to select.  In the example below, the 
Material menu was selected to arrive at the drop down menu shown. 

 
 
 
 
 
 
 
 
 
 
 
 

As mentioned previously, menus contain sub-menus and functions.  To select some functions, it may be 
necessary to first choose one or even two sub-menus first.  All sub-menus have an arrow located to the right. 

 
 
 
 To select a function from a menu or a sub-menu: 
 
 

¾ Click on the Menu name with the left mouse button. 
 

¾ Click on a sub-menu (indicated by an arrow located on the right) if one exists with the left mouse 
button. 

 
¾ Click on a function with the left mouse button and the function you select is performed. 

 
 
 
 
 
 
 
 
 
 
 
 

) NOTE:  
• You can easily cancel, or close, any menu or sub-menus that you have selected by clicking once with 

the left mouse button outside of the menu or sub-menu. 
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Using the Keyboard 
 
You select a menu by pressing F10 and then using the arrow keys to mark and display the menu.  You select a 
sub-menu and/or functions by marking them with the arrow keys and then pressing the ENTER key. 
 
 

Every screen will 
have System & Help

 
 
 To select a menu: 
 
 1. Press the F10 key and the Menu Bar is activated. 
 
 
 
 
 
 
 
 
 
 
 

) NOTE: 
F10 Toggles on & off 

 
• To cancel a selection, simply hit the F10 key. 

 
 

2. Use the                  or                   key to move to the previous or next menu, respectively.  Each time 
you press the arrow key, the previous or next menu is marked. 

 
 
 

3. Use the         arrow key to move to the sub-menus or functions located in the menu.  Each time you 
press this arrow key, a sub-menu (indicated by an arrow at the right) or a function will be marked. 

 
 
 

4. Upon arriving at the requisite sub-menu, use the               arrow to move to the next sub-menu or 
function.  This action will mark the sub-menu and bring forward other sub-menus or functions. 

 
 
5. Use the    and      arrows to move to functions.  Instead of a function, you may select another sub-menu 

if one is available. 
 
 
 
 6. Press the ENTER key on your keyboard upon arriving at the requisite function. 
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The table below shows the menus that are always available from every screen in the system 
 
 
 

 
 
Menu 

 
 
Description 

 
System 
 
 
 
Help 
 
 
 

 
The System menu contains functions that affect the system as a whole, such as Create session, 
User profile and Log off. 
 
 
The Help menu contains functions for accessing the various forms of online help that are available in 
the system. 
 
 

 
 
The Table below shows the menus that are standard in most Applications. 
 
 
 

 
 
Menu 

 
 
Description 

 
<Object> 
 
 
 
 
Edit 
 
 
 
 
 
 
Goto 
 
 

 
The first menu in the menu bar is usually named after the object you are currently working with.  
This menu contains functions, an entry on a menu that represents an action that the system 
performs, that affect the object as a whole. 
 
 
The second menu in the menu bar is the Edit menu.  The Edit menu contains actions you can use 
to edit components of the current object, for example Select, Edit, or Copy.  This menu also 
contains the Cancel function, which allows you to leave a task without the system checking and 
saving the data you have entered. 
 
 
The third menu in the menu bar is the Goto menu.  It contains functions that allow you to move 
directly to other screens of the task you are currently working in.  It also contains the Back 
function, which allows you to go back one level in the system hierarchy.  Before going back, the 
system checks the data you have entered on the current screen and displays a dialog box if there 
is a problem. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Revised 1/8/07 21  



mySAP ERP 2005 Basic Navigation Training 

 
 
 
 
 
The table below shows other menus that may also be displayed in various applications. 
 
 
 

 
 
Menu 

 
 
Description 

 
Extras 
 
 
 
Environment 
 
 
 
View 
 
 
 
Settings 
 
 
 
Utilities 
 
 

 
The Extras menu contains functions you can choose to complete the current object or an 
object component.  These are usually functions you do not constantly need. 
 
 
The Environment menu contains functions you can choose to display additional information 
about the current object. 
 
 
The View menu contains functions you can choose to display the current object in different 
views.  For example, switching between a one-line and two-line display of a table. 
 
 
The Settings menu contains functions you can choose to set user-specific transaction 
parameters. 
 
 
The Utilities menu contains functions you can choose to perform object-independent 
processing.  For example, general delete, copy, and print functions. 
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Additional Functionality on Located on the Menu Bar 
 

This page is very 
important – shows how 
to minimize, maximize 
and restore 

 

 
 

Menu Bar 
 
 
 
 
 
 
 
 Located toward the right region of the Menu Bar are three icons, the  
 middle of which may change depending on whether the window is  
 maximized or restored down. 
 
 
 
 
  Used to minimize the window (remove it from view) 
 
 
 
  Used to maximize or restore the window to maximum size 
 
 
 
  Used to restore down the window to a smaller size. 
 
 
 
  Used to close (log out) the current SAP session. 
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Standard Toolbar 
 
 
The Standard Toolbar is of particular interest, since it contains many buttons for performing common actions such as 
Enter, Save, Exit, Print, Page forward, etc.  Also located in the Standard Toolbar is the Command Field (see below), 
which is used for transaction codes, a topic yet to be discussed.  The buttons located in the Standard Toolbar remain 
the same in all applications.  However, in some applications, the buttons may not be available for use.  They will be 
shaded out.  By positioning the cursor on the buttons in the Standard Toolbar and leaving it there, a small banner will 
appear with the name of the button.  Some of the banners will also provide the corresponding function key(s) used to 
perform that function. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Standard Toolbar 

 
 
 
 
 

 
 
 

 
 
 
 
 
 
 

If the Command Field is not present on your Standard Toolbar, you need to click once 
with the left mouse button on the small arrow      in order to bring the Command Field 
into view. 

 
 
 
 
 
Command Field -  The Command Field is used for entering commands, such as Transaction Codes.  Via 

transaction codes, the user is able to go to applications directly.   
   
 
 
   Save Button –  Click this button to save your work (performs same function as 
     Save in the Edit menu). 
 
 
 
   Back Button -  Click on this button to return to the previous screen without 
     saving your data. 
 
 
 
   Exit Button Click on this button to leave the current application.  The system returns 
     to the previous application or to the main menu screen. 
 

         Print  Print a document or report 
 
 

Command Field 

Allows you to open & close command bar 

Green arrow

Yellow exit button
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Standard Toolbar continued… 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Red cancel button 
Cancel Button Click on this button to exit the current task without saving 

your data. 
 
 
 
   First Page / Previous Page / Next Page / Last Page Buttons 
   Keys used to go to the First, Previous, Next and Last page or screen. 
 
 Yellow star 
 
   Create Session Button -  This button creates a new session. 
 
 
 
 
   Generate Shortcut Button Used to create a shortcut to this transaction 
       on your desktop. 
 
 
 
   Help Button    Click on this button to display help for a field. 
 
 Will discuss in more detail later  
 
   Customizing Button   Via this button, you can change the appearance of certain 
       elements of the Window:  For example, font size, list  
       colors, sounds, cursor placement may all be manipulated. 
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Title Bar 
 
 
The Title Bar contains the name of your current application or task. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
     Title Bar 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

) NOTE:  
The heading in the Title Bar will change depending upon which task or application is being performed.  In the example 
above, the task being performed is the Creation of a Material Master record. 
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Application Toolbar 
 
 
The Application Toolbar provides the user with buttons (functions) that are available in the current application.  There 
are a profuse number of application toolbar buttons, too many to be explained.  Once you start performing your daily 
tasks, you will become familiar with the buttons you need to utilize.  To use the application toolbar, you click on the 
button located in the toolbar to perform that function. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Application Toolbar will always be positioned just below the Title Bar. 
 

 

 

 

Status Bar 
 

 
 

   Application Toolbar 
 

 
 
The application Toolbar will always be positioned just below the Title Bar 
 

 
The system displays warning and error messages in the status bar.  The Status bar also contains the system name 
(with the session number and client number in parentheses), the open or close status bar arrows, and the system time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Status Bar is very important because it shows you where you are 

 
Where you are    available choices Status Bar 

 
 

 

) # of sessions open
NOTE:  

• You may remove the information shown in the status bar by clicking on the arrow icon.  To 
reopen or bring the information back into view, simply click on the arrow pointing to the left. 
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Additional Screen Elements 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

   The Table below shows the menus that are always available from every screen in the R/3  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Pushbutton 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pushbuttons Graphical control element that you click once with the left mouse button to execute the function 
  linked to them. Pushbuttons can contain text or graphic symbols. 
 
 
Tabs  Graphical representation of additional information screens available in an application. 
 
 
Input field Field on a screen where data may be entered. 
 
 
Checkbox Graphical control element that allows the user to choose any number of elements from a list of fields. 
 
 
Radio buttons Graphical control element that allows the user to choose just one element from a field of lists. 
 
 

Tabs 

Input field 

Checkbox 

Radio Buttons 

Checkbox – Ability to select 
one, many or all 

Allows you to select one item in group 

Revised 1/8/07 28  



mySAP ERP 2005 Basic Navigation Training 

 

Moving around the system 
 
 

SAP Easy Access Screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

The SAP Easy Access screen shown below is the standard entry screen displayed after logging onto the 
system. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After logging on to the system, you need to choose the application (software program or set of software 
programs that perform a specific job; for example, Accounts Receivable and General Ledger).  Next, the task 
(one or more screens that, when completed, perform an action such as entering an invoice or displaying 
data) that you want to work on must be performed. Finally, you must choose a function (an entry on a 
menu or toolbar that represents an action to start the task, such as Save). As you are working, you may 
decide you want to start a different task, at which point you will need to choose the new application and 
function. 
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Using the Tree Structure 
 
 
To initiate the requisite task to be performed, you must drill down into the tree structure of the SAP Easy Access 
screen to access the transaction.  Follow the sample task below to see how this is accomplished. 
 
 
Task: Assume the role of an accounts receivable accountant and display a Customer master record using the SAP 

standard menu.  
 
 

Negotiating the Tree Structure 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

SAP Easy Access Screen 
 
 
 

 
 
     
� The Menu Path to be followed:  Utilities Industry > Customer Service > Front Office/Customer 

Service > (CIC0) Customer Interaction Center > Display. 
 

 
1. Position the cursor on the right pointing arrow            corresponding to Accounting and click once with the 

left mouse button. 

 

 Exercise: Set system to show transaction codes  
Extras, settings, (4 boxes) display favorites, display technical names 
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 Result: The Tree structure shown on the previous page “opens up” rendering another list of options, all 

under the Utilites Industry heading, as is depicted below.  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
NOTE: 
 Please note that the arrow you clicked on, corresponding to Utilities Industry, is now pointing down. 
 This indicates that this file is open and that the contents of the file are made available. 
  
� Utilities Industry > Customer Service > Front Office/Customer Service > (CIC0) Customer 

Interaction Center > Display. 
 

2. Position the cursor on the right pointing arrow            corresponding to Customer Service and click once 
with the left mouse button. 
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Result: The Tree structure shown on the previous page “opens up” rendering another list of options, all 
under the Customer Service heading, as is depicted below. 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
  
  
  
 

� Utilities Industry > Customer Service > Front Office/Customer Interaction Center   
  
  
3.   Complete the Menu Path by clicking on the arrows             corresponding to Customer Service and Front Office/Customer 

Interaction Center.    
 
 

  
 Once complete, the view should look similar to the one shown on the following page.   
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Result:  You will have arrived at a view similar to the one shown below.  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
  
The task, which in this example is CIC0 Customer Interaction Center, is provided for selection.  Tasks are indicated by the box 
symbol. 

 
 

  
  

4. Position the cursor on the task and double-click with the left mouse button.  
  

You will arrive at the screen of the task selected.  
  
  
  
  
  
  

 
 
 
 

Revised 1/8/07 33  



mySAP ERP 2005 Basic Navigation Training 

 

Entering Transaction Codes in the Command Field 
 
 
When utilizing transaction codes to access tasks, it is beneficial for the user to be acquainted with the following 
set of guidelines. 
 
 
For Review: Transaction codes are entered into the Command Field, which is located on the Standard 

Toolbar. 
 
 
 
 
 
 
 
 
 
 
 

 Command 

 
 

Steps for Entering a Transaction Code: 

   
To enter a transaction code and start a task, follow these steps: 

 
1. Place the cursor in the command field.  This may be accomplished by clicking once with the left 
 mouse button in the command field or by pressing CTRL + TAB. 
 
 
2. Enter /n (to end the current task) followed by the transaction code.  For example, to enter the 

transaction for creating a Sales Order, VA01, you would enter /nVA01 in the command field, as 
shown here. 

 
 
 
 
 
 
 
 
 
 
 
 

) NOTE:  
• If you have just logged onto the system and are currently not working within a 

task, it is not necessary to enter /n in front of the transaction code. 
 
 
3. Press the ENTER key and your current task is closed and the initial screen of the new task is 

displayed. 
 
 
 
 

     Field 
 
 
 
 
 

Exercise: Enter CIC0  - green arrow back 
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Creating a New Session and a Task at Once 
 
 
If you do not want to end your current task, but need to perform another task, you can create a new session 
(an additional window that can open when you want to work on more than one task at a time).  
 
For example, suppose you are creating a Sales order and you need to look at a table of exchange rates.  You 
can start a new session to look for the exchange rate table without having to end your first task of creating the 
Sales order. 
 
In the system, you can create a session and start a task in one step by using a transaction code.  When you 
open a session with a transaction code, the system displays the initial screen of the task in the new session.  
To use this method, you must know which transaction code to use for the task you want to perform. 
 
 

Steps for Creating a Session and a Task at Once 
 
To create a new session and a task at once from anywhere in the system, proceed as follows: 
 
1. Place the cursor in the command field.  This may be accomplished by clicking once with the left 
 mouse button in the command field or by pressing CTRL + TAB. 
 
 
2. Enter /o (front slash and the letter “o”) followed by the transaction code for the task you wish to 

start.  For example, to create a Sales order, you use the transaction code VA01.  To open a session 
and start this task at the same time, you would enter /oVA01 in the command field, as shown here. 

 
 
                   
 
 
The system opens an additional window for the new session and displays the initial screen of the 
transaction entered.  The system places the new window in front of all the other windows on your computer 
screen.  The new session becomes the active session and remains as such until you move to a different 
session.  You may move between sessions by holding the ALT key down and then pressing on the TAB key. 
 

) NOTE:  
• Depending on the release, there will be a maximum limit in terms of the number of 

sessions permissible. 
• You can identify which session you are currently in be looking at the status bar.  The 

session number will be in parentheses. 
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Creating a New Session Through Icon 
 
If you do not want to end your current task, but need to perform another task, you can create a new session by using 
an Icon at the top of the screen. (an additional window that can open when you want to work on more than one task at 
a time).  
 
 
Top of the screen: - 
 

 
 
 
 
 

Click this Icon To Open a New 
session  
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Finding the Transaction Code for the Current Task 
 
 
You can easily find the transaction code for the task you are currently working in. 
 
 
 

  
  

To determine the transaction code of the current task:  
  

¾ From the Menu Bar, select System > Status  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 The System: Status dialog box shown on the following page will display.  
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Creating Favorites 
 
 
The system provides a Favorites folder in which transactions (tasks) that are used routinely may be stored.  
Consequently, instead of drilling down into the tree structure or entering a transaction code in the command field to 
access a transaction, the user simply double-clicks with the left mouse button on the transaction(s) stored in the 
Favorites folder. 
 
There are two methods by which a transaction may be added to the Favorites folder.  The first method is by the use of 
the Menu Bar and the second method employs clicking and dragging. 
 
 

Creating Favorites Way of the Menu Bar 
 
 
To add commonly used transactions to your Favorites folder by way of the Menu Bar: 
 
 
 
1. Drill down into the compact tree structure as described on page to arrive at the requisite transaction (see 

example below). 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Transaction BUG1 is the transaction  
to be added to Favorites folder  

 
 
  
 
 
 
 
2. Position the cursor on the transaction name and click once with the left mouse button.  This action will 

highlight the entry. 
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3. From the Menu Bar, select Favorites > Add as shown below. 
 
 
 
  

  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    
  • The Transaction will now be positioned in your Favorites 

folder.   
  

• From this point on, the transaction will remain in the 
Favorites folder and be at your disposal. 

  
  
  

 
 
 
 
 

 
 
 

Now the required transaction is positioned in your Favorites folder.  
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Removing a Transaction from the Favorites Folder 
 
 
To remove a transaction from the Favorites folder: 
 

1. Position the cursor on the transaction name and click once with the left mouse button.  This action will 
highlight the entry. 

 
2. Using the Menu Bar, follow the Menu Path: Favorites > Delete as shown below. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 The transaction is removed from the Favorites 
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Set Start Transaction 
 
The Set Start Transaction option affords direct access to a transaction upon logging onto the system.  This option 
may be beneficial for someone that must perform the same task everyday.  For example, if a Customer Sales 
Representative is responsible for entering sales orders first thing every morning, then it may be beneficial for this 
individual to set his or her Start Transaction to VA01, the transaction required to create a sales order. 
 
By setting a start transaction, the first screen to come into view, upon logging in, will be the initial screen of the task 
selected. 
 
 
 

Steps for Setting the Start Transaction 
 
To set the Start Transaction, proceed as follows: 
 
 
1. From the Menu Bar on the SAP Main Menu screen, follow the Menu Path: Extras > Set start transaction as 

shown below. 
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The Set start transaction dialog box or  
pop-up window will display. 
 
 
 
 
 
 
 

 
 
2. Enter the Transaction code you wish to have as your start transaction in the Transaction Code field. 
 
 
3. Hit the ENTER key on your keyboard or click once with the left mouse button on the symbol located in the 

pop-up window. 
 
 
 
The transaction you have selected is now your start transaction.  The next time you logon, the first screen you will see 
will be the initial screen of the transaction selected. 
 

) NOTE:  
• A message in the Status Bar of the screen will confirm the transaction you have selected as your 

start transaction. 
 
 Exercise: Enter cic0 in transaction code – check to 

process 
 
 

Log off – log back on – brings you right to cic0 – 
(use yellow arrow to return to SAP menu) Remove Start Transaction 

 
 
 
To remove or change a Start Transaction, repeat the steps above, except delete or enter a new transaction code, 
respectively. 
 
 

) NOTE:  
• A message in the Status Bar of the screen will confirm that the Start Transaction has been reset. 
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Getting Help 
 
 
Online help is available for the fields, menus, messages, terminology, and reports.  When you need help on which value 
to enter in a field, you can access a list of possible field values, or you can use matchcodes to find a field value. 
 
Help is always available, through the function keys F1 and F4 and the Help menu.  Use F1 to get definitions and 
descriptions of fields, menus, functions, and messages.  Use F4 to display a list of possible field values or matchcodes. 
 
 
 

The Help System at a Glance 
 
 
 
The system offers extensive online help:  you can get help on: 
 
 

• fields 
 

• menus and functions 
 

• messages 
 

• terminology 
 

• reports 
 
 
 

¾ The SAP on-line help is in HTML format.  Once access to help has been realized, links to other help 
sections are provided. 

 
 

¾ The system provides detailed on-line help.  You can call help form each screen in the system by 
choosing help. 

 
¾ The Library is an online library of the entire Documentation.  You may search for the information you 

need or drill down through the applications. 
 
 
 
 

F1  
 Or 
 

Yellow “?” Icon 
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Getting Help on Fields 
 
 
Use F1 for help on fields and F4 for information on what values you can enter in a field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
1. Position the cursor on the field in question and click once with the left mouse button.  This action will 

highlight field. 
 
2. Press the F1 key for help or press the F4 key for possible entries. 
 
 
 

 
 
 F1 = Field level help  

  
F4 = Match codes or possible entries  
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Getting Help on which Value to Enter in a Field 
 
 
When you need help on which values you may enter in a field, use the F4 key to display a list of possible values or 
matchcodes.  A matchcode is a tool for finding a record that has the field value you need. 
 

 
 
 To display a list of possible field values or matchcodes: 
 
 

1. Position the cursor in the field, then select F4 or activate the field by clicking once in the field with the 
left mouse button and selecting the     icon located to the right of the field. 

 
A list of possible field values is displayed or a list of matchcodes is displayed or a message is displayed in the Status bar 
stating no values exist.  In other words, you enter your own value. 
 
 

Possible values for the 
Order Type field 
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To select a value from the drop down list: 
 
 
 
 Position the cursor on the entry and double click with the left mouse button 
 
 -or- 
 

Position the cursor on the entry and click once with the left mouse button and then select Enter      button located 
within the drop down menu. 

 
 
 

The system inserts the value into appropriate field. 
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Using a Matchcode search to Determine which Value to Enter in a Field 
 
 
A matchcode is a tool for finding records.  For example, you wish to update a material record, but you do not remember 
the material number.  You can use the information that you do remember about the material, such as the name or part 
of the name of the material or old material number, to search for the material number.  Information such as old 
material number are search terms. 
 

 
 
 To display a list of possible matchcodes: 
 
 

1. Position the cursor in the field, then select F4 or activate the field by clicking once in the field with the 
left mouse button and selecting the     icon located to the right of the field. 

 
  A dialog box will display containing tabs with different matchcode search options. 
 
 
 
 

 
 
 
 
 
 
 

2. Select the tab containing the Matchcode search option you wish to take advantage of by clicking on it once 
with the left mouse button.  Some fields may default with pre-assigned values. 
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 For this example, we have chosen to search for the Material Number using the Material Description option in 
 our search. 
 
 Assume that the user knows the Material description Starts with “3/4” ”. 
 
 

 
 
 
A couple of options are available to the user: 
 
  1. If the user knows the exact description, he or she may enter the entire description. 
 

2. Utilize the wild card, an asterisk, to substitute for letters or numbers at the beginning or end of 
the search string. 

 
   For example, to search for the Material Description “3/4”, the user may enter  
   3/4* or *3* or *3/4.  Whichever option is used, all options containing 3/4 at the  
   beginning of the description, 3 in the middle of the description, and 3/4 at the end of the 
   description will be displayed (See following page). 
 
 
 TIP:   When using the wildcard, any combination of known letters or numbers may be used in  
    front of, behind, or between the asterisk(s). 
 
 
 After the Matchcode field is populated with the requisite search criteria, press the ENTER key on your keyboard to 
 arrive at the list of results. 
 

 
 
 
 
 

Wild Card search explanation – can also be used if not sure of name, address 
* text *  ex.  Looking for 57 York Avenue but we are not sure of number or road, ave., street -  

Use *York*
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To select a value from the drop down list: 

 
 
 Position the cursor on the entry and double click with the left mouse button 
 
 -or- 
 

Position the cursor on the entry and click once with the left mouse button and then select Enter         button 
located within the drop down menu. 

 
The system inserts the value into appropriate field. 
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SAP On-Line Help 

rehensive online help.  You can display the help from any screen in the system.  You always 
ave access to help using the Help option located in the Menu Bar. 

            

 
The system provides comp
h
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Application help Displays comprehensive help on the current application.  Selecting this menu option in the 

  initial screen displays help on getting started . 

AP Lib  found. 

otes s that occur between releases. 

etplac

PNet Frontend, SAP’s service system. 

 
 
S rary  This is where all on-line documentation may be 
 
Glossary  Provides a glossary with definitions of terms. 
 
Release n  Displays notes that describe functional change
 
SAP Service  Mark e/SAPNet  Enables you to log on to SAPNet. 
 
Create Support Message Permits the user to send a message to the SA
 
Settings  Enables you to set up your own personal settings for Help. 
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Troubleshooting 
 
Many times during the processing of a transaction the user encounters errors that prevent the transaction from being 
completed.  When this occurs, SAP usually provides a message in the status bar indicating what the error is (see 
below). 
 

 

Error Message 

 

 
 

 

 

 
 

By positioning the cursor on the error message and double-

here are two kind of messages to be displayed in the 
r an 

clicking with the left mouse button, a “help” screen will 
display providing a more detailed explanation of the 
error  message. 
 
T
Status bar; a warning message that may be bypassed o
error message.  Should you receive an error message, the 
error must first be remedied before preceding any further. 
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Checklist 
 
 
When processing a transaction within the SAP System and an error will not permit you to proceed, 
refer to the checklist below. 
 
 

1. Make certain that dates entered are correct.  Some dates will default with the incorrect date. 
 
 

2. Make certain all required fields are populated.  Required fields will usually, but not always, 
have a checkmark within the field as depicted below. 

 
 
 

REQUIRED FIELDS WILL HAVE A BOX WITH A CHECKMARK 
 
 
 
 3. Utilize the Field Help F4 or F1 to ensure that the correct value is entered in each field. 
 
 

4. When encountering an error message within the Status Bar, double-click on the message to  
arrive at a detailed explanation of the error. 

 
 

5. Utilize the Application Help by following the Menu Path: Help>>Application Help to arrive  
at a view providing comprehensive help on the current application. 

 
 

6. Utilize the on-line glossary by following the Menu Path: Help >> Glossary to arrive at a  
providing a Glossary of terms. 
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Windows Commands (Cut/Copy/Paste) 
 
Ctrl-C, Ctrl-V 

• Used to copy information from one field to another 
 
To copy a field in SAP 

• Highlight the field by dragging across the field with your mouse 
• Press Ctrl-C 
• The information is copied to the clipboard 

 
To paste the data copied 

• Use Ctrl-V 
• The information on the clipboard is pasted into the selected field 

 
 
 
Ctrl-Y, Ctrl-C, Ctrl-V 

• Used to copy a range of data from a document 
 
To copy a range of fields  

• Press Ctrl-Y - Cursor will change to a cross (+) 
• Highlight the fields 

 
To copy a field in SAP 

• Highlight the field by dragging across the field with your mouse 
• Press Ctrl-C 
• The information is copied to the clipboard 

 
To paste the data copied 

• Use Ctrl-V 
• The information on the clipboard is pasted into the selected field 
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Download Data To Spreadsheet 
 

 
 
• FPL9 in the command line 
 

 
 
• Enter contract account # 
 

 
 
• From the account balance screen SYSTEM > LIST> SAVE > LOCAL FILE 
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• Select Spreadsheet 
• Green check 
 

 
 
• Name of downloaded file and its extension 
• Select Generate 

 

 
 
• Note the message at the bottom of the screen “ ####Bytes Transferred “ 

 

 
• Open Excel 
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• Navigate to locate file 

 

 
 
 

 
 

• File Located at : C:\Documents and Settings\rcanepa\SapWorkDir 
• Note the excel spreadsheet created 2/21/07 
• Double click to open the file  
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• Step 1: - Delimited > Next 

 

 
 
• Step 2: Delimiters – Tab >Next 
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• Step 3: Finish 

 

 
 
• Widen the columns, if necessary  
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• DONE 
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Download Data Via Icon 

 
• Select the Microsoft Excel icon 
 

  
• System creates an excel spreadsheet of the contact data 
 

 
 
• Saved as Contact Spreadsheet Download under my directory 
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